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1. OVERVIEW  

YuniquePLM offers an Adobe Illustrator plugin named YuniquePLM Design Suite+. It is available for 
download from the Adobe Creative Cloud desktop app.  

The YuniquePLM Design Suite+ and Adobe Illustrator compatible versions reside within the Adobe 
Illustrator plugin by pressing the About icon, as shown below. YuniquePLM does not support earlier 
versions of Illustrator CS6, CS5, or earlier. Artboards are ONLY compatible with YPLM V7.1 and later. A 
Creative Cloud installation is required to proceed.  

 

Follow the steps in this document to ensure your files are accessible via the Creative Cloud, as well as 
installing the Adobe Illustrator application and using the plugin. 
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2. CREATIVE CLOUD PREFERENCES 

It is essential to enable Adobe's sync and notification options before proceeding. The Adobe Sync 
option ensures your files and folders are available from the Creative Cloud while ensuring the user 
receives Adobe's notifications after installing an Add-on. Note: Download the Creative Cloud desktop 
app to manage and download Adobe applications easily. https://www.adobe.com/creativecloud/desktop-
app.html 

1. Click on the Creative Cloud desktop icon in the Windows taskbar or the Apple menu, as 
shown below. The Creative Cloud application opens to reveal a list of available software. 

 

2. Click the account icon to open the account menu, then select Preferences. 
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3. Select the Notifications tab, and ensure the first two options, App Updates and File 
Syncing, are checked.  

Note: Keeping all the notifications checked per your preference is okay.  

 

4. Select the Syncing tab and ensure Pause Syncing is enabled, which means Adobe's Creative 
Cloud is currently syncing all files, app updates, and notifications.  

Note: If you press Pause syncing, it changes to Resume Syncing, which pauses all 
notifications, updates, and files.  
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5. Select the Apps tab, then deselect the Auto-update option.  

If you have multiple Adobe products, you can keep the main auto-update option checked for 
all programs, then deselect the auto-update option for Illustrator. These steps ensure that 
the latest Adobe Illustrator application works with the current YuniquePLM Design Suite+ 
plugin.   

    

6. Press Done when complete.  
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3. INSTALL THE ADOBE ILLUSTRATOR APPLICATION 

The Adobe Illustrator application is required. Follow the steps below to install the application. Note: We 
recommend having one application version installed at a time. 

1. Select the Apps tab.   

2. Click on Illustration to view a list of applications.   

3. Locate Adobe Illustrator and select Install to begin the process. 

 

Note: A list of available versions is accessible by selecting All apps, clicking the 
installed program's overflow icon, and selecting Other Versions to view a version 
list. 
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4. INSTALLING AND UPDATING THE PLUGIN 

The YuniquePLM Design Suite+ is available for download from the Creative Cloud app or the Adobe 
Exchange website. The plugin is available in two versions; YuniquePLM Design Suite for YuniquePLM 
V7.X and YuniquePLM Design Suite+ for YuniquePLM V9.X or later.  

 

Installing from Creative Cloud 

1. Select the Stock & Marketplace tab.  

2. Click on the Plugins tab.  

3. Ensure the All Plugins section is highlighted. If not, click it.  

4. Type YuniquePLM within the Search All Plugins field.  

5. Locate the YuniquePLM Design Suite+ plugin and press Install. The plugin is available within 
the Adobe Illustrator application. 

 

Updating from Creative Cloud 

The YuniquePLM Design Suite+ plugin is updated, via the Creative Cloud Desktop application, when 
there is a new version of YuniquePLM. Follow the steps above to locate the plugin, then press Update.  
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Adobe Exchange  

Both plugins are available for download via the Adobe Exchange site 
https://www.adobeexchange.com/creativecloud.html. 

1. Type YuniquePLM within the search field to locate its plugin. 

2. YuniquePLM has two plugins available on Adobe Exchange. Most users should select 
YuniquePLM Design Suite+ if they use V8.X or later.  

• YuniquePLM Design Suite+: users of YPLM V8.X or later 

• YuniquePLM Design Suite:  users of YPLM V7.X  

 

3. Press the Free button on the YuniquePLM Design Suite+ product page. 

 

 

 

 

 

https://www.adobeexchange.com/creativecloud.html
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4. An End-User License Agreement appears in a separate window. Press the Accept and Continue 
button.  

 

5. Sign in with your Adobe ID when prompted, and the plugin's status changes to Acquired. Select 
Manage to install the plugin. 
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5. OPEN THE ADOBE ILLUSTRATOR APP 

1. Open Adobe Illustrator via the Creative Cloud app or your computer's menu. 

2. Open a new or existing Illustrator file. 

3. The YuniquePLM plugin may appear in two locations within the Window Menu. Select one or more 
plugins to open and dock. 

a. Click the Window menu, then Extensions, and finally, select a YuniquePLM plugin extension, 
like YuniquePLM Colors. 

 

b. Click the Window menu, then scroll down and choose a YuniquePLM plugin extension. 

 

Note: The YuniquePLM extension will not appear in the list if Adobe Illustrator is open during 
installation. Users experiencing this issue must re-launch the application to see the newly installed 
extension.  

4. The YuniquePLM extension opens. Select the Settings icon to enter the connection settings of your 
YPLM instance. 

   
 

Tip! 

Enter a name within the 
Environment Name optional 

field to easily identify the 
current environment shown 

within the app header as stated 
in Step #5. 

Enable Save Shortcuts allows 
for the use of Ctrl +S to save 

edits to YPLM. 
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Note: You need to enter the relevant connection information and credentials from the YuniquePLM 
application instance supplied by your system administrator. The details for Server, API, and PLM 
Instances are found within the Admin>WS Clients and Tools>Adobe Integration Services area of 
YuniquePLM. The user must have permission to access these areas: Image, Color, Style, Material, 
and Line List.  

 

Note: Users can now configure the color theme to match the YuniquePLM plugin. Use the Adobe 
Preferences menu (MAC: Illustrator CC> Preferences; PC: Edit> Preferences) and navigate to the 
User Interface area. Select a desired color to match the AI application. 

 
 

5. Enter your YuniquePLM username and password, then press Logon.  

 
  

Using Enterprise Logon? 

Click Enterprise Logon to launch 
a new browser where you can 
enter your logon credentials 

using an external identity 
provider which is configurable 

within YuniquePLM. 
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6. Logging into one extension automatically logs the user into all extensions, provided the user has 
permission for those areas in YuniquePLM. 

          
7. After logging in, each extension can be docked onto Adobe Illustrator's workspace. Click and drag a 

plugin into the desired dock area highlighted in blue. For more information regarding customizing 
the workspace, refer to Adobe Illustrator's help section.  

 

The YuniquePLM plugin is now ready to use with Adobe Illustrator.  

 

 
  

Tip! 

The environment name is 
reflected within the tab. 

Ex: YuniquePLM 
Materials v6.18.0@Train 
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6. USING THE PLUGIN 

The YuniquePLM plugin consists of the following extensions: Colors, Images, Line List, Materials, and 
Styles.   The Artboards section is only available within the Image and Style extensions. Please select a 
category to jump directly to its section within this document. 

 

  

Tip! 

The dynamic Panel menu 
provides users with various 

options throughout each of the 
plugins.  

Note: The refresh link syncs 
the Adobe plugin with 

YuniquePLM ensuring the user 
has the latest files.  
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6.1 Colors 

The Colors extension lists existing Color Palettes within the Color Folder. Refer to section 5. Open 
The Adobe Illustrator App to learn how to access each extension.  

Once Color opens, users can create a new color palette, which is saved into YuniquePLM, or 
choose an existing color palette created within YuniquePLM to use in the Adobe Illustrator 
workspace. Let's begin with creating a new color palette. 

6.1.1 New Color Palette 

1. Click the add new icon at the bottom right corner of the page to create a new 
color palette. 

 

2. A new window opens. Select a Palette Type, enter a Palette Name, and select 
an Active status from their respective fields. Click Save to create the palette. 

 

3. The newly created Color Palette opens with an empty list. 
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6.1.2 New Color Chip 

1. Add new colors by selecting the new color chip icon at the bottom of the color 
palette screen. 

  

2. The New Color Chip window opens, allowing the user to enter a Color Code, 
Color Name, Color Source, Color Class, Color Status, Keywords, RGB Value, 
or Hex Value.  

Click the color chip thumbnail preview or the RGB button to open the Color 
Picker window and select a desired color. Once finished, click the OK button to 
confirm.

 

3. After selecting a color, click Save to add it to the color palette in YuniquePLM.  

 

 

 

Tip! 

The Import from 
Swatches button 
allows users to 
pick colors from 
Adobe’s color 
swatch library. 
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4. The newly saved color chip opens to its Edit Color Chip window. Users may link 
an image to the color chip. Select the Link Image button to open the link image 
window. Choose an image, then press Link Image. Once complete, press 
Back to return to the newly created Color Palette page. 

 

5. The newly added color now appears in the Color Palette. Repeat the steps to 
include additional color chips. 
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6.1.3 Add from Library 

New colors can be included in a color palette from YuniquePLM's Color Library. 
Users can now access their favorite colors from libraries such as Pantone, A&E, and 
Coloro.  

1. Press the Add from Library button to view a list of color libraries. 

  

2. A new window opens with a list of available color libraries from YuniquePLM.  
Select a color library to view a list of colors. 
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3. The selected color library opens and displays a collection of colors. Check one 
or more colors, then press Add Colors. 

 

4. A confirmation window appears, notifying the user of the successful addition of 
the new color. Press okay to confirm the additional color and press Back to 
return to the primary color palette window.  

 

 

 

 

Tip! 

Quickly add a 
color by clicking 
and dragging it 
onto the Adobe 

Illustrator 
workspace. 
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5. Users may add a Color Palette or Color Chip to Adobe Illustrator's Swatches 
panel using the Add to Swatch icon.

 

6. Also, users can quickly Set Fill Color or Set Stroke Color by selecting the 
desired color and pressing its respective icon. 
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6.1.4 View Existing Color Palettes 

1. Use the Palette Name, Palette Type, or Search fields to locate a desired color 
palette. Click the color palette's respective pencil icon to view and edit. 

 

2. A new window opens, displaying the selected color palette's detail. The palette 
type, palette name, and active fields can be modified. A new palette type and 
name can be created by entering a different name and selecting a different 
palette type. Please note that the fields that appear throughout the extension 
might differ based on the configurations within the environment. 

3. Click Save to keep the changes or press Back to disregard and return to the list 
of color palettes. 

 

 

Tip! 

Use the bottom icons to 
create a new color 

palette, view a color 
palette, edit the 

selected color palette, 
add to swatch, or 

delete a color palette.  
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4. Select an existing Color Palette by double-clicking to view all its colors. 

5. Colors within the palette may be searched using the search fields or Advanced 
Search options at the top of the window. Click the Back button to return to the 
Color Palettes list view.  

 

 

 

 

 

 

 

  

Tip! 

 
Pressing the Goto button opens a browser to 

the selected color palette in YuniquePLM. Use the bottom icons to add a 
new color chip, add from 

library, edit selected color chip, 
add to swatch, set fill color, set 

stroke color, or delete the 
selected color chip. 
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6.1.5 Edit a Color Chip 

1. Double-click a color chip to open its window, which contains specific information 
associated with the color. Here, users can modify the Color Code, Color Name, 
Color Source, Color Class, Color Status, Value (RGB and Hex value), Link 
Image, and Import from Swatches. 

 

2. The user may change the color by clicking the color chip preview thumbnail 
to launch the Color Picker window. Choose a color by clicking within the colored 
area or changing the values associated with the color. Once finished, click OK 
to keep the changes or Cancel to disregard any changes made. Press Back 
twice to return to the color palette list.   

 

  

Tip! 

The Link Image 
button opens a new 
window so the user 
can select an image 

to link with the 
selected color chip.     

Tip! 

The Color Picker window toggles 
between Color Swatches and 

Color Models when its respective 
button is pressed.    
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6.2 Images  

The Images extension displays a list of images from the Image Folder. Refer to section 5. Open 
The Adobe Illustrator App to learn how to access each extension. 

Once the Image extension opens, users can create a new image, which is saved into 
YuniquePLM, or choose an existing image created within YuniquePLM to use in the Adobe 
Illustrator workspace. Let's begin with creating a new image. 

6.2.1 New Image 

1. Click the New Image icon at the bottom right corner OR click on the menu 
within the top right corner and select New Image. 
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2. The user can open a blank file, open a file stored on the local drive, choose 
from a list of available open documents, or copy an image from the image 
library. For example, the user would choose from a list of opened Illustrator files 
imported into the system after making some modifications. Select a Source File 
option, then enter the image's header information into the corresponding data 
fields.  

 

3. The newly added image appears in the upper left corner above previously 
viewed or edited images. Once finished, click the Save button. 

 

4. Press Back to return to the main image screen.  
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6.2.2 View Existing Image 

1. Search for the desired image using the search filters option. A list of images, 
identified by their name and file type (AI, PNG, JPG, PSD, and HEIC), appear for 
users to choose from. AI's files are currently the only editable format. 

2. Double-click an image to view its edit options. 

 

3. Users may edit header information within the data field entries. Click Save to 
keep the changes.  

 

Create a 
new 
image 

Panel 
menu 

Search 
area 

View 
and 
edit an 
image  

File Type: 
Illustrator 

Tip! 

Filenames within the Image area now 
follow a new naming convention.  

• Image 
description_image#_version #.jpg 
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a. Are you using an Illustrator file? Double-click its thumbnail to open it in 
Adobe Illustrator. Apply any necessary changes to the image and click 
Save.  

 

b. Click the History tab to view the image's previous modifications.  

 

 

 

 

 

Tip! 

Pressing the 
Goto button 

opens a browser 
to the selected 

image in 
YuniquePLM. 

Tip! 

Double-click a 
previous version of 

the image to make it 
the primary selection.  
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4. Click the Back button to return to the Image search results window. 

 

5. Users may select another image from this area or search for another using 
different image attributes. Double-click an image to view its attributes.

 

 

  

Tip! 

Press the Session 
History button to 
return to the last 

edited image. 
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6. This image appears in the left thumbnail column above the image previously 
edited. Users may change the image header information or the image itself if it is 
an Illustrator file. Press the Save button to keep any changes made to the current 
image. 

Remember, the Save & Close button saves changes and closes the current 
image. The Save All  button saves every image currently opened.  

 

7. Close an Image from the Session History by clicking the X button at the top right 
corner. Please note that this does not delete the image; it just removes it from 
your session history. 

8. Press Back to return to the Image Folder main screen. 

 

Tip! 

The Image and Style 
extensions contain a visual 
notification indicating to the 
user that changes were 
made and need to be saved. 

• Blue icon: modified 
Text attributes ex. 
Image type, 
description 

• Red icon: modified 
image 

   

Tip! 

Press the pencil icon 
on the image to open 
and edit within Adobe 

Illustrator. 
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6.2.3 Adding a Color Swatch to an Image 

Users can modify the colors on an image using a color chip from the YuniquePLM 
Color app.   

1. With an image opened on the main workspace, ensure the YuniquePLM Color 
app is also opened. 

2. Select Adobe's Direct Selection tool, then click and drag a YuniquePLM color 
swatch onto the image. Once the color swatch is dragged onto the image, the 
color swatch is displayed along with the color code and name assigned to the 
color chip. 

 

3. Select the color square and drag it to the Swatches tab. 

 

4. The color swatch is now available on the image using Adobe Illustrator's tools. 
Use the direct selection tool to drag the color swatch onto desired areas of the 
image. 
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6.3 Line List 

The Line List extension displays existing Line Lists created in YuniquePLM.  Users can also create 
and edit line lists while adding and removing Styles from the Line List. Refer to section 5. Open 
The Adobe Illustrator App to learn how to access each extension. 

Once the Line List extension opens, users can create a line list that will be saved into YuniquePLM 
or choose an existing line list created within YuniquePLM to use in the Adobe Illustrator 
workspace. Let's begin with creating a new line list. 

6.3.1 New Line List 

1. Click the New Line List icon at the bottom right-hand corner OR click on the 
menu within the top right corner and select New Line List. 

 

2. Add the necessary information within each field, then click Save to keep the 
changes. 

 

New 
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3. A new window opens where styles can be added to the new line list. 

 

 

6.3.2 Adding Styles to a Line List 

1. Press the Add Styles icon within the new line list to open its window. 
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2. Select a Style, then press Add Styles. The Style has been added to the new 
Line List. Add more Styles as needed. Press cancel to return to the line list 
page. 

 

 

 
  

Want to remove a 
style from the Line 

List? 

Select a style, then 
press the remove 

styles icon. 
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6.3.3 View existing Line Lists 

1. Search for the desired line list using the search filters option. A list of line list, 
identified by their name and file type, appear for users to choose from.  

2. Double-click a Line List to view its Style collection.  

 

a. Users may edit header information within the data field entries by 
selecting the pencil icon within the line item or bottom right-hand corner. 
Click Save to keep the changes, or press Back to return to the home 
page. 

  

 

Search 
area 

View 
and 
edit a 
line 
list 

New, 
Edit or 
View 
selected  
line list 

Dynamic 
Panel 
menu 
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3. The Line List opens and displays each Style. Users can add and remove Styles 
using their respective icons while double-clicking a Style to view its details and 
colorways. Note: Users can click and drag an image and a colorway onto the 
artboard for editing.  

 

4. The Colorways tab now indicates whether a color is active or dropped within the 
Dropped column. Users may also add a colorway to Adobe Illustrator's Swatch 
panel (add to swatch), set a fill color and set stroke color. 

 

 

  

Tip! 

Quickly and easily 
add or remove a 

Style from the Line 
List. 
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5. One or more styles can be exported to the Adobe Illustrator workspace by 
selecting a Style or pressing Select All, then drag the styles to the workspace 
OR press the Export to Workspace button. The Style's details and colorways 
are listed.  

6. Press the View Attachments icon to view this Line List's attached files.  

 

7. Press the Export to PLM button to save a document to a Line List within 
YuniquePLM.  
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8. Double-click the attachment to open and edit within Illustrator's workspace. 
Save the modifications, which are saved within the extension and YuniquePLM. 

 

9. Press Back to return to the main Line List page. 

 

 

  

Tip! 

Pressing the Goto 
button opens a browser 
to the selected image 
in YuniquePLM Image 

Library. 
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6.4 Materials 

The Materials extension displays a list of materials from the Material Folder. Refer to section 5. 
Open The Adobe Illustrator App to learn how to access each extension. 

Currently, the Materials area ONLY allows users to view a list of available materials created within 
YuniquePLM. 

1. Select the Materials tab to view a list of materials from the Material Folder. Refer to section 5. 
Open The Adobe Illustrator App to learn how to access each tab. 

2. Search for the desired material using the search filters option.  

3. View a list of materials identified by their name, type, and number. Users can also drag a 
material onto the artboard.  

   

Panel 
menu 

Search 
area 

View a 
material 
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6.5 Styles   

The Styles extension displays a list of styles from the Styles Folder. Refer to section 5. Open The 
Adobe Illustrator App to learn how to access each extension. 

Once the Style extension opens, users can create a new style, which is saved into YuniquePLM, 
or search for an existing style created within YuniquePLM to use in the Adobe Illustrator 
workspace. Let's begin with creating a new style.  

6.5.1 New Style 

1. Click the New Style icon at the bottom right-hand corner OR click on the 
menu within the top right corner and select New Style. 
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2. Select the appropriate Style Header related information within each drop-
down and click the Next button. 

 

3. Complete the rest of the Style Header information on the next page and 
click Save. Note: Required fields contain an asterisk.  

 

 

Tip! 

Filenames within the Style area now follow a 
new naming convention.  

• Style name_Style description_front or 
back_version #.file extension 
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4. The new Style opens with the option to add front/back images, modify its 
Style attributes and create or view BOM colorways. Add images by hovering 
over the front or back image and press new image. Users can also link or 
unlink an image.  

 

5. The new image window opens with several options. The user can open a 
blank file, open a file stored on the local drive, choose from a list of 
available open documents, or copy an image from the image library. For 
example, the user would choose from a list of opened Illustrator files 
imported into the system after making some modifications. Select a Source 
File option, then enter the image's header information into the 
corresponding data fields. 

 

Tip! 

Users of AI Plugin V5.3.0 or later, 
can use the Save, New Image, Link, 
Unlink and Close shortcuts within 
each Style image.  
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6.5.2 Link Image 

1. The new Style contains no associated images. The user may link their desired 
images using the Link Image button or selecting Link Image from the drop-
down menu. Use the image search window to locate the desired image.  

 

2. Click an image, then press the Link Image button.   
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3. A pop-up window opens with the option to select whether you want the image 
shown in the front or the back. Choose the Front Image option and press OK. 
Repeat the process to link the Back Image. 

 

4. Click the Save button to keep the changes to the new Style.  

Remember, the Save & Close button saves any changes and closes the 
current Style. The Save All button saves every currently opened Style.  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
  

Tip! 

The Image and Style extensions 
contain a visual notification, 
indicating to the user that 
changes were made and need to 
be saved. 

• Blue icon: modified Text 
attributes ex. Style Type, 
Style No, Description 

• Red icon: modified 
image 
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6.5.3 Creating a New BOM 

1. Select the BOM tab to view a list of available BOMs.   

2. Users may also add a new BOM by selecting the Create New BOM button. 

 

3. A new window opens. Add the required attributes, then press save. 

 

4. The new BOM is saved and listed. Double-click the new bom to add materials.
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6.5.4 Adding Materials 

1. Press the Add Materials button to view a list of materials. Select the desired 
materials, then press Add Materials. Close the window. 

 

2. The newly added materials are now listed within the BOM. Users can designate 
a main material by checking the MAIN box.   Also, a material can be removed by 
selecting it and pressing the trash icon. 
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6.5.5 BOM Colorways 

1. Select the Show BOM Colorways icon to open the Colorways window. 

 

2. The Colorways window opens and lists any included colorways. To add 
colorway, press its respective button. 
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3. The add colorway window opens. Select all desired colors, then press add 
colors. Close the window. 

 

4. The added colors are now included on the Style BOM's Colorway window. 
Users may also select a colorway to drop from the BOM, set it back to active, 
add it to a swatch in AI, set the fill or stroke color, and can remove a 
colorway. 
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6.5.6 Goto 

1. Click the Goto… button to open a browser to view the selected Style in 
YuniquePLM. 
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6.6 Artboards  

Adobe allows multiple pages within a single illustrator file called Artboards. YuniquePLM allows 
users to upload and use Artboards ONLY within the Image and Style extensions.  

Users are unable to upload Artboards directly into YPLM. If you directly link an artboard image from 
the Image folder to a Style in YPLM, it will not automatically associate all related artboard files. 
Mass linking images to a Style can ONLY occur within the Style extension.  

1. Open Adobe Illustrator.  

2. Select the Window menu and press Artboards. 

 

3. The Artboards window opens. Press New to add an Artboard using the following configuration 
example below to match the Control Panel Artboard entries. Note: The names can be rewritten 
by double-clicking the text.  

• Front: Map to Style Header front image. 
• Back: Map to Style Header back image. 
• Design: Map to Design Images -Text Image workflow page. 
• Technical: Map to Text Image workflow page Technical Details Sub Workflow. 
• FrontColorway: Map to Front Colorway for the corresponding Style Colorway. 
• BackColorway: Map to Back Colorway for the corresponding Style Colorway. 
• Freelance: Maps to Freelance design workflow page. 
• Measurements: Maps to single 'How to measure' image on the Style 

Measurements Workflow page. 
• Detail: Maps to the Design Detail Style Workflow Page. 
• DesignCustom: Maps 

to Design Detail 
custom page. 

Refer to How to Link Images to 
Styles for further details. 
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6.6.1 Artboard View 

The Image tab displays all images within an Artboard in a thumbnail view, while the 
currently viewed image is highlighted within the thumbnail area.  

 

A visual notification is presented once an image is modified, either by the Illustrator 
view or the text attributes. 

 Blue icon: Indicates the text attributes were modified—for example, Image 
Type, Description, or File Type.  

 Red icon: Indicates the image was modified within the Illustrator workspace.  

 

 

 

 

Thumbnail 
View 

Artboard 

Highlighted 
(Current) Image 
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6.6.2 Artboard Sorting  

The artboard images can be rearranged using the Artboard panel's menu.  

1. Select an artboard to rearrange, then press either the up or down arrow. Within 
this example, the Front image was moved from the 1st position down to the 3rd.  

 

2. Click within the upper right-hand corner to open the menu. Select Rearrange 
Artboards to sort the images on the Adobe Illustrator workspace automatically.  
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3. Press save within the YuniquePLM Image tab to reflect the artboard 
rearrangement onto the Image thumbnails.  

 

 

  

Tip! 

Notice the Front image 
has been relocated to the 

third position on the 
Artboard workspace as 

well as the thumbnail area. 
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6.6.3 How to Link Images to Styles 

Each created Artboard needs to match up to a Control Panel Artboard entry.  

1. Within YuniquePLM, click the Home button and press the Control Panel link 
within the left navigation bar.  

2. Expand the AI Plugin folder, then click Artboard Style Linking.  

3. This area contains pre-listed artboard entries, which can be modified to fit the 
user's preferred names or create a new entry.  

a. Double-click an entry to modify its configuration settings. 

 

b. Or press new to create and map your entries. 

 

 

  

Tip! 

Make sure to select 
Yes for the Update 
With Last Version 

option to automatically 
update changes made 
from the artboard AI 

plugin to the 
YuniquePLM Style. 



 

GERBER YUNIQUEPLM 

 

Gerber YuniquePLM is a registered trademark of Lectra. Other trademarks 
mentioned in this document are the property of their respective owners. 

 
lectra.com 55/60 

 

4. Use the following example to match up the artboard entries: 

 Front: Map to Style Header front image. 

 Back: Map to Style Header back image. 

 Design: Map to Design Images - Text Image workflow page. 

 Technical: Map to Text Image workflow page Technical Details Sub Workflow. 

 FrontColorway: Map to Front Colorway for the corresponding Style Colorway. 

 BackColorway: Map to Back Colorway for the corresponding Style Colorway. 

 Freelance: Maps to Freelance design workflow page. 

 Measurements: Maps to single 'How to measure' image on the Style 
Measurements Workflow page. 

 Detail: Maps to the Design Detail Style Workflow Page. 

 DesignCustom: Maps to the Design Detail custom page. 
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Any artboard image can be assigned to a Style. However, users will likely match the 
Front for the Front Image. Once linked, it automatically associates the other artboard 
images to the other workflow pages based on the control panel mapping.  

 

This also creates the Text Image sub-workflow pages based on the Control Panel mappings. 
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6.6.4 How to Link Colorway Images  

Double-click an Artboard entry to type in the colorway color code directly after the 
name. Placing the color code within the name will map the entry to the appropriate 
colorway within YPLM. Example: FrontColorwayImages18-1664 TCX is the 
corresponding mapping (18-1664 TCX is the color code for the colorway used on the 
BOM).

 

 

6.6.5 Updating Artboard Images  

Once an artboard is assigned to a Style, any updates to the artboard images are 
automatically updated back in the Style. (This depends upon the control panel 
option, Update With Last Version is set to YES within new or pre-existing artboards). 

 

  

 

  

Tip! 

Make sure to select Yes for 
the Update With Last Version 
option to automatically update 

changes made from the 
artboard AI plugin to the 

YuniquePLM Style. 



 

GERBER YUNIQUEPLM 

 

Gerber YuniquePLM is a registered trademark of Lectra. Other trademarks 
mentioned in this document are the property of their respective owners. 

 
lectra.com 58/60 

 

6.6.6 Removing Images in an Artboard 

1. Open the desired Artboard file within the YuniquePLM plugin. (Access the file 
from the Image Folder or Style Folder extensions.) The Artboard file should open 
within the main Adobe Illustrator window.  

2. Select an artboard to remove within the Artboards window. Click on the 
designated artboard, then press the delete (trash can) icon. 

 

3. Remove any illustrations from the now deleted artboard page. 
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4. Save the file within the YuniquePLM extension. This will break the link of the 
deleted artboard image in the image folder with the rest of the artboard files.  

Remember, the Save & Close button saves any changes and closes the current 
Style. The Save All button saves every currently opened Style. 

 

5. Press the Goto button to open a browser to the selected image in YuniquePLM. 

6. Once the deleted artboard image opens in YuniquePLM, a message displays 
stating the image was removed from an artboard. You can remove this image 
from where it was previously used within the Style Folder. 

Note: Deleting in Adobe Illustrator does not automatically delete an image within 
PLM or within remove/delete that image from a Style it was being used on. A user 
must manually remove that image from anywhere it was used within PLM. 
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6.6.7 Tip for Text Image Artboards  

Placing a 1-10 after the Artboard name helps to identify each image and the page it 
will be mapped to in YuniquePLM. Example: Design1, Design2, Design3, 
Technical1, Technical2 etc. Keep in mind that users can not save duplicate Artboard 
names.  
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